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This application note covers testing of an ampliier’s linear S-parameters and gain compression 
using Keysight Technologies, Inc. microwave (MW) PNA Series of vector network analyzers. The 
MW PNA Series can also be used for testing ampliier nonlinear parameters such as harmonics 
and intermodulation distortion. Keysight Application Notes 1408-8 and 1408-9 cover the topics of 
harmonics and intermodulation distortion testing respectively.

Ampliiers are a fundamental building block of microwave systems, and characterizing the 
performance of ampliiers is a critical factor in the design process. Network analyzers are 
traditionally used for linear ampliier measurements, while spectrum analyzers are used for nonlinear 
measurements such as harmonics and intermodulation distortion. However, many of the modern 
network analyzers, including the Keysight MW PNA Series, can be used for nonlinear measurements 
as well, by enabling the frequency-offset functionality. 

Note: The step-by-step procedures in this application note were written for PNA (836xA/B) and 
PNA-L (N5230A) network analyzers with irmware revision A.04.06. If you have a PNA or PNA-L with a 
different irmware revision, the step-by-step procedures or screenshots may vary. The concepts and 
general guidelines still apply.

Introduction
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Gain
Ampliier small signal gain is deined as the ratio of an ampliier’s output power 
delivered to a Z0 load to the input power delivered from a Z0 source, where Z0 

is the characteristic impedance in which the ampliier is used (50 ohms in this 
note). In logarithmic terms, gain is the difference in dB between the output and 
input power levels at a particular frequency. 

Reverse isolation
Reverse isolation is a measure of transmission from output to input. The mea-
surement of isolation is similar to the measurement of small signal gain, except 
that the stimulus is applied to the ampliier’s output. 

Deviation from linear phase
Ideally, the phase shift through an ampliier is a linear function of the frequency 
applied. The amount of variation from this theoretical phase shift is called devi-
ation from linear phase or phase linearity.

Group delay
Group delay is a measure of the transit time through an ampliier at a particular 
frequency. It is deined as the derivative of the phase response with respect to 
frequency. Similar to deviation from linear phase, it is a measure of ampliier 
distortion.

Return loss/SWR
Return loss is a measure of the quality of the match of the input and output of 
the ampliier, relative to the system impedance. Relection coeficient includes 
both magnitude and phase information of the relected signals. Return loss and 
SWR are ways of examining the magnitude portion of the relection coeficient.

Gain compression
An ampliier has a region of linear gain, where the gain is independent of the 
power level. This gain is commonly referred to as small signal gain. As the input 
power is increased to a level that causes the ampliier to approach saturation, 
the gain will decrease, resulting in a large signal response. In this application 
note, the 1 dB gain compression is deined as the input power level where the 
ampliier gain drops 1 dB relative to the small signal gain. 

Deinitions

In this application note, the device 
under test (DUT) is an ampliier with 
the following speciications. 

Frequency range 0.10 to 

1000 MHz

Minimum small 

signal gain

20 dB

Input SWR 1.5:1

Output SWR 2.0:1

Output 1 dB 

compression

+3 dBm

Note
MW PNA [front-panel keys] are shown in 
brackets, while the softkeys are displayed in 
bold; “menu item” refers to the Windows® 
drop down menus.
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Step 1: Setup
The irst step of a transmission measurement is to set up the stimulus settings 
of frequency range, power level, number of points, and IF bandwidth. 

[Preset]
[Start/Center] > Start 0.1  [G/n]  > Stop 1  [G/n] 
[Power] > Level  –20  [Enter]

In addition to damage level, it is advisable to consider the compression level of 
the network analyzer. In the 0.1 to 1 GHz frequency range, the MW PNA receiv-
ers have 0.6 dB compression at +5 dBm test port input power. 

Given our ampliier’s gain of approximately 20 dB and input power level of 
–20 dBm, the result will be a signal with roughly 0 dBm of power incident upon 
the test port. Therefore, we do not need to enable the receiver attenuators in 
this example. If necessary, the receiver attenuators can be enabled via the menu 
item Channel, Power…

Transmission  
Measurements

ECal

PNA network analyzer

Amplifier

Figure 2. MW PNA internal receiver attenuators make ampliier measurements easier by reducing the 
need for external attenuators.

[Sweep Setup] > Points > 401 [Enter]

MW PNA Series allows the user to measure up to 16,001 points. If you have 
an ampliier with a wide frequency span, measure more points to get better 
frequency resolution. Alternatively, calibrate with many points over a wide 
frequency range. Then zoom in on a subset of the frequency range and still have 
excellent resolution and many calibrated points. 

[Sweep setup] > Bandwidth 

Verify that the network analyzer’s IF bandwidth is set to the default 35 kHz. 
This is probably an adequate bandwidth for ampliier gain measurements, since 
a gain measurement does not require the maximum dynamic range, and you 
want to maximize measurement speed. If you have a high dynamic range ilter 
connected to the ampliier as part of the DUT or would like to lower the system 
noise, reduce the bandwidth. MW PNA Series offers a range of IF bandwidths, 
from 1 Hz to 40 kHz.

Figure 1. Setup for testing transmission and 
relection parameters.

Note
At preset, the source power level of the MW 
PNA Series network analyzer is set to –17 
dBm, with the internal source attenuator on 
port 1 set to 0 dB. If the ampliier under test 
could be damaged by this power level, or 
will be operating in its nonlinear region, do 
not connect the ampliier until you have set 
a desirable power level. 
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High gain ampliier considerations
When measuring high gain ampliiers, it is possible to damage the test port cou-
plers, receivers, receiver attenuators, or source/splitter assembly. For the MW 
PNA, the damage levels are: +20 dBm at the test port (limited by the source/
splitter assembly), +30 dBm for the couplers and bias-tees (if the source/splitter 
assembly is protected through source attenuation), +15 dBm for the receivers, 
and +30 dBm for the receiver attenuators. The MW PNA source attenuators 
(Option UNL) cover a 60 dB range, in 10 dB steps.  The receiver attenuators 
(Option 016) cover a 35 dB range, in 5 dB steps. 

If the ampliier output is connected to the test port input, do not apply more 
than +20 dBm to the test port input, since power levels higher than +20 dBm 
will damage the source/splitter assembly. If you have the source attenuator 
option, you can apply 10 dB or more of source attenuation, and then apply +20 
dBm to the coupler input. You also have to protect the receiver, via the receiver 
attenuator. Though there is at least 14 dB of loss between the test port and the 
receiver, due to the coupler. 

If the ampliier output is connected directly to the receiver input, via the front 
panel jumpers, then the signal is not incident upon the source/splitter assembly, 
and is directly incident upon the receiver or receiver attenuator. In such a case, 
the damage level is +15 dBm if the receiver attenuator is not used, and +30 dBm 
if the receiver attenuator is switched in. If you use the receiver attenuator, you 
can put in +30 dBm into the jumper input, apply 15 dB of attenuation, and make 
a valid measurement.

Please note that all of the power levels mentioned in Step 1 are damage levels. 
We recommend that you reduce the incident power upon the receivers well be-
low the damage level, and even below the compression level, to obtain the most 
accurate measurements. 

When measuring high gain ampliiers, it is recommended that you take advan-
tage of the “Port Power Coupled” feature to uncouple the power of ports 1 and 
2. Drive the input, or port 1, with a low power level as to not damage the output 
receivers. Drive the output, or port 2, with a high power level, so the isolation or 
S12 measurement does not approach the noise loor of the network analyzer. An 
accurate S12 measurement is fundamental to an accurate 2-port calibration.
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Step 2: Calibrate
A two-port calibration provides the maximum accuracy for this measurement. 
Keysight’s electronic calibration (ECal) modules make the task of calibration 
much easier and less prone to user errors. You can learn more about ECal by 
visiting our website at www.keysight.com/ind/ecal.

[Cal] > Cal Wizard

Figure 5. The MW PNA status bar provides you with valuable information, including the calibration 
type and status. 

Figure 4. With the MW PNA’s Windows 2000 operating system, ile manipulation is as easy as it is on 
your personal computer.

Figure 3. The MW PNA Calibration Wizard simpliies various calibration procedures.

Follow the recommended steps in Calibration Wizard. Save the instrument state 
with a pointer to the calibration set as a ile “ampliier.cst.”

Once the calibration has been completed, verify that it is active. Turn on the 
network analyzer Status Bar by selecting it under the menu item View, and 
verify that the calibration indicator “C 2-P SOLT” appears on the bottom of  
the screen. 
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Step 3: Measure
Next connect the ampliier between port 1 and 2, and perform the measure-
ments. Be sure to apply any appropriate biasing.

Gain or S21 

Small signal gain is gain of the ampliier in its linear region of operation. This is 
typically measured at a constant input power over a swept frequency range.  

[Measure] > S21 

Group delay
Group delay, like deviation from linear phase, is a measure of ampliier phase 
distortion. The MW PNA calculates group delay from the phase and frequency 
information and displays the results in real time. This measurement may require 
a speciic group delay aperture. The minimum aperture is equal to the frequency 
span divided by the number of points minus one. Increasing the aperture reduc-
es the group delay resolution, but lowers the trace noise.

Deviation from linear phase
The deviation from linear phase measurement employs the electrical delay 
capability of the MW PNA to add electrical delay to the ampliier in order to 
remove the linear portion of the phase shift.  

To view the gain in different formats, we can easily take advantage of the 
multi-parameter display capability of the MW PNA, by using a preconigured 
setup. Conigure window 2 for phase measurement, window 3 for group delay, 
and window 4 for deviation from 
linear phase. 

[Measure Setups] > Setup B

Select window 2. [Measure] > S21 > [Format] > Phase
Select window 3. [Measure] > S21 > [Format] > Delay
Select window 4. [Measure] > S21 > [Format] > Phase

[Marker] > [Marker function] > >Delay 

Place the marker in the center of the ampliier frequency span, and then acti-
vate the electrical delay function. By lattening the phase response, we have 
effectively removed the linear phase shift through the ampliier under test. The 
deviation from this linear phase shift remains.
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Reverse isolation or S12

For an isolation measurement, the stimulus is applied to port 2, or the output 
of the ampliier, and the signal level at port 1, or the input, is measured. For 
ampliiers with very high isolation, the noise loor of the MW PNA Series can be 
lowered by reducing the IF bandwidth.

At this point, you may want to recall the original instrument state to start with a 
clean trace, or you can remove the delay that was added in the previous step.

[Recall] > ampl… cst
[Measure] > S12

Figure 6. View multiple ampliier parameters on one screen, using MW PNA’s 4-parameter display 
capability.
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Step 1: Setup

Relection measurement can be made using the same setup as transmission 
measurements. 

Step 2: Calibrate
Relection measurement can be made using the same two-port calibration as 
transmission measurements. 

Step 3: Measure

Input and output return loss – S11 and S22
Return loss and standing wave ratio (SWR) are commonly speciied for the 
ampliier’s input and output ports. With the MW PNA Series, you can view the 
relection parameters in return loss or SWR format. 

First set up an S11 trace and then add an S22 trace to the current display.
menu item Trace > [Measure] > S11 > [Format] > [Format] > SWR
menu item Trace > New 
Select second trace [Measure] > S22

Relection 
Measurements

 

Note
If the ampliier under test is operating in its 
nonlinear region, the large signal S22 should 
be measured using a load-pull technique. 
Traditional S-parameter measurements de-
pend on the ampliier operating in its linear 
region.

 

Figure 7. Measure the input and output match of an ampliier using the MW PNA.
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There are two ways to measure ampliier gain compression: swept frequency 
gain compression and swept power gain compression. 

Swept frequency gain compression
This measurement allows the user to easily determine the frequency at which 
1 dB gain compression irst occurs. This is accomplished by normalizing to 
the small signal gain and by observing the reduction in gain as input power is 
increased. 

Swept power gain compression
By applying a ixed frequency power sweep to the input of an ampliier, gain 
compression is observed as a 1 dB drop in the gain from the small signal value. 
The ixed frequency chosen is often the frequency for which 1 dB compression 
irst occurred in the swept frequency gain compression.  

Gain compression can be speciied in terms of both input power and output 
power. Since gain compression is speciied at an absolute power level, absolute 
power accuracy is desired. With the MW PNA Series, a source power calibra-
tion (same as power meter calibration) provides input power accuracy, while a 
receiver calibration provides output power accuracy. 

Gain Compression
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PNA network analyzer

Amplifier

EPM power
meter

Power sensor

Figure 8. Setup for testing gain compression 
and swept-harmonic response measurements

Figure 9 . Measure gain with an S21 trace.

Channel Sweep type Traces Frequency Source 

power 

Calibration

Swept frequency gain 

compression

Ch 1 Frequency 

sweep

1 trace, S
21

0.1 to 1 GHz –20 dBm 2-port cal

Swept power  

gain compression

Ch 2 Power sweep 2 traces, S
21

 and B 0.1 GHz –25 to 0 dBm 2-port cal,  

Src Pwr Cal, Rcvr Cal

Step 1: Setup

Recall the “ampliier.cst” instrument state as a starting point for channel 1.  

[Recall] > ampl… cst
[Measure] > S21

Conigure channel 2, using the menu item Trace, with two traces: an S21 and a 
B trace. Be sure to select channel 2, as the network analyzer defaults to 
channel 1. A “B” receiver measurement allows you to observe the absolute 
output power of the ampliier. Use the menu item Trace, and then More Types… 
Unselect Ratioed Type.

In this procedure, we will take advantage of the multi-channel and multi-trace 
features of the MW PNA Series. 

Conigure the MW PNA as follows:
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Next conigure channel 2 for a power sweep, from –25 dBm to 0 dBm.

[Sweep Type] > Power Sweep 
[Power] > Start Power > –25 [Enter]
Stop Power > 0 [Enter]
[Start/Center] > CW Freq > 100 [M/µ]

Figure 10. Measure absolute output power 
with a B trace.

Figure 11. Conigure S21 traces as the initial step for swept frequency gain compression
(top trace), and swept power gain compression (lower traces).

Perform a quick check on the measurement before calibrating the test setup. The 
S21 trace of channel 1 should display the approximate gain of the ampliier, while 
the S21 and B traces on channel 2 should show a typical gain compression curve.

Step 2: Calibrate
Once the setup in complete, perform a calibration on both channels. On 
channel  1, you can use the calibration from the irst step – a two-port 
calibration is adequate.

On channel 2, perform three calibrations: (1) A 2-port calibration on the S21 

trace, (2) a source power calibration on the S21 trace, and (3) a receiver calibra-
tion on the B trace. Perform the 2-port calibration using the ECal module. 

The source power calibration functionality is located under the menu item 
Calibration.
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Connect an appropriate power sensor to test port 1 and then perform  
the calibration. 

Figure 14. A receiver calibration provides 
output power accuracy.

Figure 13. A source power calibration adjusts the output power of the network analyzer for 
absolute power accuracy.

Figure 12. Source power calibration transfers the accuracy of a power meter 
measurement to the MW PNA source. 

Next, perform a receiver cal. A receiver cal is essentially a trace normalization, 
similar to a response cal. The difference between a receiver cal and a response 
cal is that a receiver cal is performed on the B receiver and provides absolute 
accuracy, whereas a response cal is performed on an S21 measurement and 
provides relative accuracy. An accurate receiver cal starts with a source power 
cal as the reference. 

Make a through connection between port 1 and port 2 and perform the 
calibration
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Step 3: Measure
Once both calibrations are complete, connect the ampliier and observe the 
display. Note the status bar on Figures 15 and 16. On Figure 15, S21 is selected 
and the status bar shows a “2-P SOLT” and “Src Pwr Cal”. On Figure 16, B is 
selected and the status bar shows a “Rcvr Cal” and “Src Pwr Cal”. 

Figure 15. A 2-port cal is applied to the S21 trace. Figure 16. A Rcvr Cal is applied to the B trace.

Now that the calibrations are complete, start the gain compression 
measurement.  

Channel 1: Swept frequency gain compression
Select the S21 trace of channel 1. Normalize the trace by using the data to 
memory functionality of the MW PNA. 

[Math/Memory]  > Data >> Memory > Data/Mem

The modiied S21 data trace should show 0 dB gain. Next, using the rotary 
knob, increase the source power level until the trace drops by 1 dB at some 
frequency point. 

[Power]  > Level  > Increase power using the knob

A marker can then be used to track the exact frequency where 1 dB compres-
sion irst occurs. Observe the power level on the display. This is the approximate 
input power level for the 1 dB compression. 

Channel 2: Swept power gain compression
Select the S21 trace on channel 2. Place a marker on the trace. Move the marker 
to the lat portion of the trace. If there is no lat portion, the ampliier is in com-
pression throughout the sweep, and the start power level must be decreased. 

[Marker] > Marker 1  > Move the marker using the knob

Use the delta marker function to ind the power level for which a 1 dB drop in 
gain occurs. Use the coupled marker function to place a marker on the B trace 
and display the absolute input and output power where compression occurs.
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The B trace marker x-axis value (stimulus) is the input power level and the 
y-axis value (response) is the output power level at which the ampliier irst 
compresses. This measurement can be repeated at multiple frequencies, if 
desired.

Figure 17. Measure the 1 dB compression accurately using the MW PNA network analyzer.
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Gain
The major sources of error in a gain measurement with a network analyzer are 
the frequency response of the test setup, the source and load mismatch during 
measurement, and the system dynamic accuracy. The frequency response of 
the test setup is the dominant error in a transmission measurement. A simple 
response calibration signiicantly reduces this error. For greater accuracy, a full 
2-port calibration can be used. Mismatch uncertainties are a function of effec-
tive source and load mismatches. A full 2-port calibration not only reduces the 
effects of frequency response, it also improves the effective source and  
load match. 

Dynamic accuracy, a measure of the receiver’s performance as a function of 
incident power level, also inluences the uncertainty of gain measurements. This 
is because a receiver usually sees a different power level between calibration 
and measurement. 

Reverse isolation
Isolation is subject to the same error considerations as gain. In addition, if the 
isolation of the ampliier under test is very large, the transmitted signal level 
may be near the noise loor and/or crosstalk level. To lower the noise loor, 
employ averaging or reduce the IF bandwidth. To reduce crosstalk, perform an 
isolation calibration.

Relection 
The uncertainty of relection measurements is affected by directivity, source 
match, load match, and the relection tracking of the test system. With a full 
2-port calibration, the effects of these factors are minimized. A 1-port calibra-
tion provides the same accuracy if the output of the ampliier is well terminated, 
or if the ampliier’s reverse isolation is considerably larger than its gain. Since 
the magnitude of the mismatch uncertainty depends on the input and output 
match of an ampliier, a measurement of a better-matched ampliier will contain 
less uncertainty.

Gain compression
Swept frequency gain compression measurements employ response calibrations 
to reduce uncertainties. Be aware, however, that to determine swept frequen-
cy gain compression, the source power level must be changed. Therefore, the 
validity of the response calibration is reduced when varying source power for 
swept frequency measurements. Swept power gain compression measurements 
employ source and receiver calibration to reduce uncertainties. A source power 
calibration precisely sets the power level incident upon the ampliier by com-
pensating the source power for any nonlinearities in the source or test setup.

Accuracy 
Considerations
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Both power level linearity and power level accuracy are PNA output speciica-
tions (versus input speciications), so they are related to the PNA source and not 
the PNA receivers. The E8362/3/4B speciications are listed below.

E8362/3/4B with options 014 and UNL speciications

Frequency Range Power Level Accuracy Power Level Linearity

10 to 45 MHz ±2.0 dB ±1.0 dB

45 MHz to 10 GHz ±1.5 dB ±1.0 dB

10 to 20 GHz ±2.0 dB ±1.0 dB

20 to 40 GHz ±3.0 dB ±1.0 dB

40 to 45 GHz ±3.5 dB ±1.0 dB

45 to 50 GHz ±4.0 dB ±1.0 dB

Power level accuracy refers to the possible deviation of power level from trace-
able power levels. For example, let's look at the 45 MHz to 10 GHz frequency 
range. It has a power level accuracy of ±1.5 dB. That means that if you measure 
the output power of a PNA in this range, 0 dBm for example, it can be between 
–1.5 and 1.5 dBm.  

Power level linearity refers to the error in a power sweep condition. The best 
example where these two speciications are applicable is gain compression 
measurements. 

Gain compression is measured over a frequency range and a power range. 
However, 
calibrating at all frequencies and all power levels can be a time-consuming task. 
So invariably the user asks the question, "What is the measurement error if I 
don't calibrate at all frequencies and all power levels?" 

Let’s assume you are measuring an ampliier with an input power of –30 to 
0 dBm, with a frequency range of 1.8 GHz to 2.4 GHz. You set up an S21 and 
B receiver measurement, with a frequency sweep, 201 points, covering 1.8 to 
2.4 GHz, 0 dBm power level. You perform a source power cal and receiver cal at 
–10 dBm, and a two-port cal to correct for systematic errors. Thus, you are fully 
calibrated with this stimulus. Now you change the setup to power sweep, with 
a range of –30 to 0 dBm (have not changed the attenuator settings), with a CW 
frequency of 1.8 GHz.  

Note
You can measure the output power with a 
power sensor and power meter. A source 
power calibration allows the user to trans-
fer the accuracy of a power meter mea-
surement to the PNA. A receiver calibration 
following a source calibration allows the 
PNA receivers to be used for very fast and 
accurate measurements.

Note
Power sensors are broadband devices and 
thus measure the total output power of the 
PNA. That means both the fundamental 
power and harmonic power are measured. 
On the receiver side, the network analyzer 
is a tuned receiver, so only the fundamental 
power is actually measured. Fortunately, 
the error due to the harmonic power is 
fairly small, compared to other errors. The 
second harmonic speciication of the PNA 
source is –23 dBc, for power range 0. This 
translates to approximately ±0.02 dB of 
measurement uncertainty; a very small 
value. Mismatch error is one of the larger 
error terms. Assuming a raw PNA source 
match of 12 dB, and a power sensor match 
of 22 dB, the mismatch error is about ±0.15 
dB. The PNA Series offers a “Scalar Mixer 
Calibration” which can be used for absolute 
power measurements and corrects for this 
mismatch error. 

Note
There are three PNA features that can 
really help optimize and speed up cali-
bration. (1) ECal (2) A feature in source 
power cal called “Use Reference Receiver 
for Fast Iteration” (3) Copy channel. An 
understanding of these features will allow 
you to be more eficient. Refer to the PNA 
internal Help System for more information 
regarding these features.

Difference between 
Power Level Accuracy 
and Power Level 
Linearity
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If you did not perform a source power cal on this power sweep range, the error 
that would apply to the absolute source power here is the power linearity error, 
which is ±1.0 dB. Thus the worst case scenario is that your source could say –25 
dBm, but you are actually getting –24 dBm or –26 dBm. Power linearity error 
is not applicable if you perform a source power cal over the power range you 
are making measurements. Of course ±1 dB is the warranted speciication.  In 
practice, most analyzers in a narrow frequency range and narrow power range 
will have much better linearity. A test of a new analyzer at the factory showed 
that for the above frequency and power setting, the linearity error was less than 
0.1 dB.  

You can perform an experiment, as described here, to determine the approxi-
mate linearity of your setup. 

 – Set the trace to S21, frequency sweep, with a power level in your power 
sweep range, (for example –10 dBm, 1.8 to 2.4 GHz). Perform a source 
power cal at –10 dBm. 

 – Next copy channel 1 to channel 2. 
 –  On the original channel, channel 1, change the sweep type to power sweep, 

with a CW frequency of 1.8 GHz, and the desired power sweep range (–30 
to 0 dBm).  

 – On channel 2, also change the sweep type to power sweep, set the sweep 
range to the same as channel 1 (–30 to 0 dBm), and perform another source 
power cal. 

 – Now on channel 1, you have source power cal* (interpolated1 version), and 
on channel 2, a fully calibrated source power cal for your power sweep 
range. 

Compare the results. This will tell you what the difference is between perform-
ing a source power cal over the entire power sweep range, versus calibrating at 
one point and interpolating over the rest of the range.

The linearity determined here is experimental, analyzer speciic, and not trace-
able to NIST. So if you have very stringent measurement uncertainty require-
ments, it is best to perform a calibration at all measurement points. 

1. To be precise, the source power cal in this case is not interpolated. The offset calculated 
from the 1.8 GHz, –10 dBm point is applied to other power levels. The application of an 
offset, or use of interpolation of extrapolation, is dependent on the frequency and power 
settings and the availability of calibration data.  
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